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           April 11th, 2019 
Bing Wu, PhD 
Review Editor 
JoVE 
 
Dear Dr. Wu, 
 
We are delighted to submit our revised manuscript, “In Vivo Imaging of Cerebrospinal Fluid 
Transport through the Intact Mouse Skull using Fluorescence Macroscopy” for your 
consideration (Reference # JoVE59774). 
 
We present a manuscript that describes a detailed methodology for macroscopic tracking CSF 
influx in vivo. In addition to other methods to studying CSF influx into the brain, we believe that 
in vivo transcranial macroscopic imaging helps us to better understand glymphatic influx. While 
2-photon microscopy has a superior spatial resolution, the field of view is limited and requires an 
intensive surgical procedure. MRI also gives insight to whole brain CSF dynamics, but it lacks 
the spatial and temporal resolution. Our method has enhanced spatial resolution compared to 
MRI and does not require the rigorous surgery that 2-photon microscopy often does. 
Transcranial macroscopic imaging through the whole mouse brain gives us great insight into 
CSF influx in real-time and allows for many adaptations, including TBI, which can be seen in our 
results.  
 
We would like to thank you for giving us the opportunity to revise our manuscript. The editorial 
comments and concerns directed us to take the time to further improve our manuscript. 
Our revisions include the following: 

1. All protocol steps are now in the proper tense, with no use of personal pronouns 
2. Removed all highlighting from cautions and notes 
3. Protocol steps were reduced to 4 lines or fewer, unless indicated  
4. We have added a co-author, Xiaowei Wang. She was influential in preparing the re-

submission and Dr. Wang has reported no conflicts of interest. 
 
Please find our reply to the reviewer comments in an accompanying file. 

 
Best regards,  
 

With best regards, 
 

 
 
Maiken Nedergaard 
Frank P. Smith Professor, Department of Neurosurgery 
Chief, Division of Glial Disease 
Co-Director, Center for Translational Neuromedicine 
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SHORT ABSTRACT:  26 
Transcranial optical imaging allows wide-field imaging of cerebrospinal fluid transport in the 27 
cortex of live mice through an intact skull.   28 
 29 
LONG ABSTRACT:  30 
Cerebrospinal fluid (CSF) flow in rodents has largely been studied using ex vivo quantification of 31 
tracers. Techniques such as two-photon microscopy and magnetic resonance imaging (MRI) have 32 
enabled in vivo quantification of CSF flow but they are limited by reduced imaging volumes and 33 
low spatial resolution, respectively. Recent work has found that CSF enters the brain parenchyma 34 
through a network of perivascular spaces surrounding the pial and penetrating arteries of the 35 
rodent cortex. This perivascular entry of CSF is a primary driver of the glymphatic system, a 36 
pathway implicated in the clearance of toxic metabolic solutes (e.g., amyloid-β). Here, we 37 
illustrate a new macroscopic imaging technique that allows real-time, mesoscopic imaging of 38 
fluorescent CSF tracers through the intact skull of live mice. This minimally-invasive method 39 
facilitates a multitude of experimental designs and enables single or repeated testing of CSF 40 
dynamics. Macroscopes have high spatial and temporal resolution and their large gantry and 41 
working distance allow for imaging while performing tasks on behavioral devices. This imaging 42 
approach has been validated using two-photon imaging and fluorescence measurements 43 
obtained from this technique strongly correlate with ex vivo fluorescence and quantification of 44 
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radio-labeled tracers. In this protocol, we describe how transcranial macroscopic imaging can be 45 
used to evaluate glymphatic transport in live mice, offering an accessible alternative to more 46 
costly imaging modalities. 47 
 48 
INTRODUCTION:   49 
Cerebrospinal fluid (CSF) bathes the brain and spinal cord and is involved in maintaining 50 
homeostasis, supplying nutrients, and regulating intracranial pressure1. CSF in the subarachnoid 51 
space enters the brain through a network of perivascular spaces (PVS) surrounding cortical pial 52 
arteries and then flows down along penetrating arterioles2. Once in the parenchyma, CSF 53 
exchanges with interstitial fluid (ISF), carrying harmful metabolites such as amyloid-β (Aβ) and 54 
tau protein aggregates out of the brain through low resistance white matter tracts and 55 
perivenous spaces2,3. This pathway is dependent on astroglial aquaporin-4 (AQP4) channels and 56 
has therefore been termed the glial-lymphatic (glymphatic) system4. Waste products of the 57 
neuropil are ultimately cleared from the CSF-ISF through lymphatic vessels near cranial nerves 58 
and in the meninges out towards the cervical lymph nodes5. The failure of this system has been 59 
implicated in several neurologic diseases such as Alzheimer’s disease6,7, traumatic brain injury3, 60 
and ischemic and hemorrhagic stroke8.  61 
 62 
CSF transport can be visualized by infusing tracers into the cisterna magna (CM)9,10 and 63 
glymphatic studies in the past have mainly utilized two-photon microscopy4,11-13, magnetic 64 
resonance imaging (MRI)14-17, and ex vivo imaging3,6,11,18 to evaluate tracer kinetics. Two-photon 65 
microscopy is a suitable method for detailed imaging of CSF tracers in PVSs and the parenchyma 66 
due to its high spatial resolution, however, it has a narrow field of view and requires an invasive 67 
cranial window or thinning of the skull. Ex vivo imaging, in combination with 68 
immunohistochemistry, enables multilevel analyses ranging from single cells up to the whole 69 
brain19. However, the process of perfusion-fixation that is required to observe the post-mortem 70 
tissue produces profound changes in CSF flow direction and collapses the PVS, significantly 71 
altering the distribution and the location of the tracers12. Finally, while MRI can track CSF flow 72 
throughout the entire murine and human brain, it lacks spatial and temporal resolution of 73 
perivascular flow.  74 
 75 
A new technique, transcranial macroscopic imaging, solves some of these limitations by enabling 76 
wide-field imaging of perivascular CSF transport in the entire dorsal cortex of living mice. This 77 
type of imaging is done with an epifluorescent macroscope using a multiband filter cube, tunable 78 
LED light source, and high-efficiency CMOS camera10. These set-ups are able to resolve PVSs up 79 
to 1-2 mm below the skull surface and can detect fluorophores up to 5-6 mm below the cortical 80 
surface while leaving the skull entirely intact10. Multiband filters and LEDs that can quickly tune 81 
the excitation wavelength enable the use of multiple fluorophores allowing CSF to be labeled 82 
with tracers of different molecular weights and chemical properties in the same experiment.  83 
 84 
This procedure requires a simple, minimally invasive surgery to expose the skull and place a light-85 
weight head plate to stabilize the head during the imaging session. Tracers can be delivered into 86 
the CM without drilling into the skull or penetrating the cortical tissue with pipettes or 87 
cannulas9,20. Both CM cannulas and head plates remain stable for several days to weeks and 88 



  

 

facilitate more complex experimental designs compared to the classical end-point visualization. 89 
This protocol describes how transcranial macroscopic imaging is used to study glymphatic system 90 
function following acute or chronic injection of fluorescent CSF tracer into the CM of 91 
anesthetized/sleeping or awake mice.  92 
 93 
PROTOCOL:  94 
All experiments were approved by the University Committee on Animal Resources (UCAR, 95 
Protocol No. 2011-023) at the University of Rochester and performed according to the NIH Guide 96 
for the Care and Use of Laboratory Animals.  97 
 98 
1. Preparing the cisterna magna cannula, head plate, and head holder 99 

 100 

1.1. Sterilize all surgical instruments and head plates before surgery. 101 

 102 

NOTE: Fluorescent tracers are delivered directly into CSF via a cisterna magna cannulation. For 103 

detailed instructions on this procedure, please refer to Xavier et al9.  104 

 105 
1.2. Briefly, using a needle driver, break the tip of a 30G x 12.7 mm (½ inch) needle, ¾ of the 106 

way down, and place the blunt end of the needle into one end of polyethylene 10 (PE10) tubing 107 

(about 45 cm long). Make sure that only the bevel is protruding out of the border of the PE10 108 

tubing. 109 

 110 

1.3. Break off ¼ of the beveled end of another 30G needle and place the blunt end of the 111 

remaining needle into the other end of the PE10 tubing, with the plastic Luer-lock still attached.  112 

 113 

1.4. Fill a 100 µL glass syringe with sterile, artificial CSF (aCSF: 126 mM NaCl, 2.5 mM KCl, 1.25 114 

mM NaH2PO4, 2 mM MgSO4, 2 mM CaCl2, 10 mM glucose, and 26 mM NaHCO3).  115 

 116 
1.5. Attach the syringe to the end of the line and fill it with aCSF until it reaches the tip of the 117 

beveled needle. It is important that the syringe is backfilled with aCSF and not air, as an air 118 

column is more prone to variable infusion volumes.  119 

 120 

1.6. For chronic experiments, leave the line filled with aCSF and skip Step 1.7. 121 

 122 

1.7. For acute experiments, place the syringe on an infusion pump and withdraw 123 

approximately 5 mm of air, which will prevent mixing. Afterwards, withdraw the total volume of 124 

tracer(s) that is desired for the experiment (20% extra is recommended due to dead space losses).  125 

 126 
NOTE: The PE10 tubing should be long enough so that the air bubble does not enter the plastic 127 

cuff of the glass syringe when loading the tracer. For a typical experiment, the protocol uses 10 128 

µL of bovine serum albumin conjugated to Alexa Fluor 647 (BSA-647) diluted in aCSF at 0.5%. 129 

 130 



  

 

1.8. Confirm that the head plate fits into the head holder and that it is the right size for the 131 

mouse being used. Anatomical markers to ensure this are: the top border of the window aligns 132 

with the interocular line and the posterior border falls rostral to the occipital crest.  133 

 134 

NOTE: Stainless-steel head plates can be sterilized and reused. Most cyanoacrylate mixtures can 135 

be removed with an acetone solution.  136 

 137 

2. Surgical procedure 138 

 139 

2.1. Weigh and anesthetize the mouse (e.g. ketamine/xylazine; 100 mg/kg ketamine, 10 140 

mg/kg xylazine; i.p.). 141 

 142 

2.2. Once the mouse no longer responds to a toe pinch, moisten the neck and head with sterile 143 

water and shave using clippers. Once the area is shaved, wipe the area with an alcohol swab 144 

again to remove any residual hair.  145 

 146 
NOTE: Moistening the fur before clipping dramatically reduces the amount of hair in the imaging 147 

window after the incision.  148 

 149 

2.3. Place the mouse in a stereotactic frame on top of a temperature-controlled pad and apply 150 

petroleum ophthalmic ointment to the mouse’s eyes to ensure they do not dry out. 151 

 152 

2.4. Clean the exposed skin with a chlorhexidine swab. After 2 min, remove the chlorhexidine 153 

with an alcohol wipe. Finally, apply an iodine solution which can be left to dry. 154 

 155 

2.5. Apply topical analgesia (0.25% Bupivacaine HCl) to the top of the skull and the neck. 156 

 157 

2.6. Starting on the part of the neck that covers the occipital crest, make a midline cut in the 158 

overlying skin and continue rostrally towards the interorbital line. Incise laterally to the border 159 

where the temporal muscle inserts into the skull. Remove all of the skin of the fusiform incision 160 

to expose both the frontal and parietal bones.  161 

 162 
CAUTION: The retroorbital sinus lies caudal to the eyes and large branches of the posterior facial 163 

vein lie rostral to the pinna. Be careful when making the incision to spare these structures. If this 164 

occurs, stop bleeding by maintaining hemostasis with a sterile cotton swab for several minutes 165 

and continue. 166 

 167 

2.7. Irrigate the skull with sterile saline and clean the surface using cotton swabs so that it is 168 

free of debris and hair since these will interfere with the image quality. Skull transparency is best 169 

preserved by leaving the periosteum and overlying fascia intact.  170 

 171 



  

 

NOTE: If these structures are accidentally removed, the skull can become dry and opaque over 172 

time. Re-moisten with aCSF or use a mixture of paraffin oil and glycerol to reduce skull reflectance 173 

in acute experiments21.  174 

 175 

2.8. Proceed to inserting the cisterna magna cannula - for surgical details of this procedure, 176 

refer to Xavier et al9. 177 

 178 

2.9. After inserting the CM cannula, apply a mixture of dental cement with cyanoacrylate glue 179 

to the ventral side of the head plate around the border and place it on the skull so that the 180 

anterior border of the head plate aligns with the posterior tip of the nasal bone and the posterior 181 

border aligns with the anterior aspect of the interparietal bone, making sure that the sagittal 182 

suture (midline) is centered and straight relative to the window (Figure 1B).  183 

 184 
2.10. Fix the position of the head plate using a couple drops of glue accelerator. Fill any 185 

remaining gaps with the cement mixture and cure it with accelerator.  186 

 187 
CAUTION: Make sure the cyanoacrylate does not come in contact with the mouse’s eyes or block 188 

the imaging window.  189 

 190 

2.11. Glue the CM cannula to the head plate to ensure that these do not become detached 191 

during transport or when the mouse wakes up. 192 

 193 

2.12. For acute experiments, skip to Step 2.16. 194 

 195 

2.13. For chronic experiments, apply a thin layer of clear-drying cyanoacrylate glue to the 196 

exposed skull, being careful not to create bubbles as these will interfere with the imaging. The 197 

glue provides protection for the skull and will not interfere with the imaging. Make sure that the 198 

glue covers the exposed skull all the way to the skin at the incision border.  199 

 200 

2.14. Use a hemostat clamp to hold the aCSF-filled PE10 tubing 2-3 cm from the CM and cut the 201 

line with a high-temperature cautery tip. Once it is separated, flatten the melted PE10 tubing to 202 

seal the cannula.  203 

 204 

CAUTION: Make sure not to release the clamp until after the cannula has been sealed and confirm 205 

there are no leaks in the tubing to prevent a CSF fistula. 206 

 207 

2.15. Administer carprofen (5 mg/kg every 24 h for 3 days; i.p. or s.c.) and return the mouse to 208 

a temperature-controlled, single-housed cage and allow it to recover for at least 24 h prior to 209 

imaging. Do not leave the mouse unattended until it regains sufficient consciousness to maintain 210 

sternal recumbency. Intact cranial windows remain stable for several weeks.  211 

 212 



  

 

NOTE: The chronic experiment can be paused here.  213 

 214 

CAUTION: Some postoperative complications are: cephalohematoma/subgaleal hematomas, CSF 215 

fistula, and infection.  216 

 217 

2.16. For acute experiments, place the mouse into the head holder using the head plate so the 218 

skull is in a fixed position. Make sure to check anesthesia level and place a heating pad under the 219 

mouse. The mouse is now ready to be taken to the macroscope.  220 

 221 

CAUTION: Carefully transport the mouse together with the infusion pump on a cart. If the CM 222 

cannulation becomes dislodged, it will cause a drop in intracranial pressure and any CSF leaks will 223 

alter the experimental results. 224 

 225 

3. Preparing the mouse for imaging 226 

 227 

NOTE: The protocol varies depending on whether the imaging experiment will be performed on 228 

an anesthetized (start at Step 3.1) or awake (start at Step 3.2) mouse.  229 

 230 

3.1. Anesthetized Mice 231 

 232 

3.1.1. Place the head holder on the stage of the macroscope, making sure there are no kinks in 233 

the line from the syringe pump to the CM cannula and that it is not taut since this could affect 234 

the tracer infusion.  235 

 236 

3.1.2. Observe respiratory rate and pink coloration of the mucous membranes, indicating good 237 

oxygenation. Inject saline subcutaneously to secure hydration level if necessary. Check to make 238 

sure the animal is sufficiently anesthetized and re-dose if needed. 239 

 240 

3.1.3. Turn on the macroscope camera and LED and start LIVE mode.  241 

 242 
3.1.4. Confirm the magnification of the imaging field so that the nasofrontal suture at the top 243 

of the field and the lambdoid suture at the bottom can clearly be visualized, with the sagittal 244 

suture parallel and centered to the middle of the image (Figure 1C). Once in place, secure the 245 

head holder to the macroscope stage with tape.   246 

 247 

3.1.5. Focus the macroscope on the exposed skull. Despite macroscopes having a relatively large 248 

depth of field, the curvature of the mouse’s skull only allows for a specific area to be in focus. 249 

Best results are obtained when the focal plane is located on the lateral sides of the parietal bones 250 

posterior to the coronal sutures.  251 

 252 



  

 

NOTE: This is the location of the middle cerebral arteries (MCA), where most CSF inflow occurs 253 

(Figure 1D,E)10. 254 

 255 

3.2. Awake Mice  256 

 257 

3.2.1. Prior to the imaging session, let the animals recover for at least 24 h from the head plate 258 

surgery. Longer recovery periods (5-7 days) are also recommended. During this time, train the 259 

mouse to be head fixed on the stage in the restraint tube for 0.5-1 h per day for the duration of 260 

the recovery period.  261 

 262 

NOTE: Habituation allows the mouse to be attached to the head holder without anesthesia and 263 

reduces stress and anxiety during the actual experiment. If this is not feasible and anesthesia 264 

does not interfere with the experiment, an induction dose of an inhaled anesthetic (e.g., 265 

isoflurane 2% at 1-2 L/min O2 flow rate) can be used to quickly attach the mouse to the head 266 

stage.  267 

 268 

3.2.2. Once the mouse is fixed to the head holder and in the restraint tube, follow Steps 3.1.1-269 

3.1.5.  270 

 271 

4. Infusion of fluorescent CSF tracers 272 

 273 

4.1. Acute CM Cannulation 274 

 275 

4.1.1. Since the tracer was already loaded into the cannula before being placed in the cisterna 276 

magna in Step 1.6, set the infusion pump to the desired rate and volume. Infusion paradigms 277 

routinely used are 5-10 µL at 1-2 µL/min, but these parameters can be adjusted depending on 278 

the particular experiment, or the size and age of the animal. 279 

 280 

4.2. Chronic CM Cannulation 281 

 282 

4.2.1. Prior to beginning the imaging session, follow Steps 1.2-1.7 for acute experiments to 283 

prepare the infusion line to deliver the tracers.  284 

 285 

4.2.2. Once the line is prepared, using a hemostat clamp cut the sealed end of the chronic CM 286 

cannula. Take the needle from the line prepared in Step 4.2.1 and gently insert it into the cannula. 287 

Release the clamp and using the syringe pump, advance the CSF tracer at the desired infusion 288 

rate (e.g., 2 µL/min) for the experiment until the tracer reaches the implanted needle in the CM.  289 

 290 
CAUTION: If the needle pierces through the tubing when connecting the line, remove the needle, 291 

cut the pierced segment and repeat this step. Any tear in the PE10 tubing will cause a leak and 292 

affect the results of the experiment. 293 



  

 

 294 

5. Setting up the Imaging Session 295 

 296 

5.1. Based on the fluorescent tracer being infused, determine the excitation wavelength and 297 

the exposure time for each channel. Choose the shortest exposure time necessary to visualize 298 

the tracer in order to maximize the temporal resolution of the time-lapse imaging. This exposure 299 

time will be used for all subsequent experiments aiming to compare CSF transport between 300 

different animals.  301 

 302 

NOTE: One tip is to use the tracer in the CM line to adjust the exposure time. Although this is a 303 

useful first approach, this should be optimized over time. 304 

 305 

5.2. Choose the duration of the experiment and the intervals at which the images will be 306 

acquired. Experiments normally last between 30-60 min depending on what phase of glymphatic 307 

transport is of interest. Frame rates of 1 frame/min and faster are sufficient for most 308 

experiments. 309 

 310 

5.3. Set the file name and the saving directory. 311 

 312 

5.4. If the imaging will be collected in addition to simultaneous acquisition of other variables 313 

(e.g., electrocardiogram, arterial blood pressure, electrophysiology), the macroscope and pump 314 

can be programmed to be triggered with the data acquisition software. Check that the triggering 315 

function on the macroscope is correct before moving to the next step. 316 

 317 

6. Transcranial optical imaging experiment 318 

 319 

6.1. Start the tracer infusion and the imaging at the same time. 320 

 321 

6.2. Routinely check the CM cannula and the PE10 tubing for any signs of a leak. If there is any 322 

tracer leaking at the CM, the results from this experiment must be excluded. 323 

 324 

NOTE: If tracer starts to accumulate in the cerebellum and does not travel the glymphatic 325 

pathway of the MCA, it is likely that the CM cannula was injected into the cerebellum. This data 326 

should not be included. 327 

 328 

6.3. For acute experiments, after completion of the experiment, remove the mouse from the 329 

microscope and check that it is still adequately anesthetized. Quickly decapitate the mouse and 330 

harvest the brain tissue. Immersion-fix the brain in 4% paraformaldehyde (PFA) overnight at 4 °C.  331 

 332 

6.3.1. For chronic experiments, once the imaging is completed, remove the CM line from the 333 

cannula, flush with sterile aCSF and reseal the CM cannula with a high-temperature cautery tip. 334 



  

 

Remove the mouse from the head stand and return it to its cage. Repeat this process until further 335 

imaging is not required and then follow Step 6.3. 336 

 337 

7. Data analysis 338 

 339 

NOTE: Matlab-based analyses, such as CSF front-tracking can extract large amounts of 340 

quantitative data from the tracer fronts in these imaging datasets10,22. However, these file types 341 

can also be easily imported and analyzed in open-source image analysis software like Fiji23.  342 

 343 

7.1. Import the image stacks into Fiji using the Bio-Formats import tool. This function will 344 

preserve the file metadata which includes the time and pixel resolution. Save the image stack as 345 

a .tiff file.  346 

 347 

7.2. Manually draw a region of interest (ROI) around the skull or the area of interest using the 348 

polygon selection tool. For example, in Figure 1G an ROI was drawn separately for the ipsilateral 349 

and for the contralateral hemisphere after a traumatic brain injury. Make sure to add the ROI 350 

into the ROI Manager (Analyze>Tools>ROI Manager) and save it.  351 

 352 

NOTE: CSF transport can be quantified in two main ways: 1) mean fluorescence intensity over 353 

time or 2) influx area expressed as a percentage of the ROI or total area (mm2) after having 354 

applied a threshold. The latter method (Figure 1H) will be described in the next steps. 355 

 356 

7.3. Set the threshold on the frame with maximal fluorescence (Select 357 

Image>Adjust>Threshold…). Automated threshold methods such as Otsu are normally good at 358 

detecting CSF tracer. Apply the threshold. 359 

 360 

7.4. Before going forward, make sure that in Analyze>Set Measurements, the options Area 361 

and Area Fraction are selected. Then in the ROI Manager, select More>Multi Measure. 362 

 363 

7.5. Convert the %Area value into mm2 using the Area value of the ROI from the output. The 364 

%Area values reflect the percent of the dorsal cortical surface with CSF tracer.    365 

 366 

7.6. Plot CSF tracer influx in mm2 as a function of time. 367 

REPRESENTATIVE RESULTS: 368 
CSF influx is imaged on an epifluorescent macroscope (Figure 1A), which allows for mesoscopic 369 
imaging of CSF tracer transport in the murine cortex. The whole-skull head plate permits the 370 
visualization of the rostral nasal bones, both frontal and parietal bones in the center, and the 371 
rostral portion of the interparietal bone caudally (Figure 1B). During imaging, the nasofrontal, 372 
sagittal, coronal, and lambdoid sutures can be readily identified (Figure 1C). Once the infusion of 373 
CSF tracer into the CM begins (Figure 1D), tracer fluorescence is first seen in large pools of 374 
subarachnoid CSF at the basal cistern, olfactofrontal cistern, and the quadrigeminal cistern near 375 



  

 

the pineal recess (Figure 1E, left). CSF tracers then enter the brain along perivascular spaces of 376 
the cortical pial branches of the middle cerebral artery (MCA) (Figure 1E, right).  377 
 378 
Transcranial optical imaging can be used to study glymphatic function after traumatic brain injury 379 
(TBI)3. Mice received a moderate TBI and immediately afterwards a fluorescent CSF tracer (BSA-380 
647) was injected into the CM24. CSF transport was imaged for 60 min after TBI (Figure 1F). 381 
Macroscopic imaging shows that tracer is first seen at the olfactofrontal cistern but glymphatic 382 
influx along cortical PVSs is completely abolished on the side of the TBI (Figure 1G, Supp. Movie 383 
1). The inhibitory effect of TBI on glymphatic function has been shown using several other tracer 384 
quantification methods and could underlie the relationship between TBI and the accumulation 385 
of Aβ and tau seen after injury3. Quantitative analysis of in vivo images show that ipsilateral influx 386 
area is decreased nearly a third compared to the contralateral hemisphere (Figure 1H).  387 
 388 
FIGURE LEGENDS:  389 
Figure 1. Transcranial macroscopic imaging. (A) Schematic of the macroscopic imaging set up. 390 
(B) Dorsal view of the position of the head plate on the skull. The interparietal bone and the nasal, 391 
frontal, and parietal bones are all visible. (C) An exposed mouse skull during imaging before CSF 392 
tracer has appeared, clearly showing all cranial sutures of the intact skull. Scale bar: 1 mm (D) 393 
Schematic of a lateral view of CSF tracer entering the cisterna magna (CM) and traveling from the 394 
basal cistern along the glymphatic pathway. (E, left panel) Macroscopic imaging of glymphatic 395 
influx in a ketamine-xylazine anesthetized wildtype mouse at 20 minutes post CM injection (BSA-396 
647; 10 µL at 2 µL/min). CSF tracer is seen in the olfactofrontal cistern around the rostral rhinal 397 
vein below the nasofrontal suture, along some parts of the superior sagittal sinus below the 398 
sagittal suture, and in the pineal recess surrounding the transverse sinus below the lambdoid 399 
suture. (E, right panel) Digital magnification of the image on the left shows the high spatial 400 
resolution obtained with these microscopes. CSF tracer travels within the perivascular spaces of 401 
the middle cerebral artery (MCA)10. Scale bar: 0.5 mm (F) Experimental timeline. An anesthetized 402 
wildtype mouse received a moderate traumatic brain injury (TBI)24 and immediately after a CM 403 
injection (BSA-647; 10 µL at 2 µL/min), followed by 60 min of macroscopic imaging. (G) Time-404 
lapse images of CSF tracer transport after TBI (dashed line).  Scale bar: 1 mm (H) Influx area (mm2) 405 
over each hemisphere during the 60-min experiment, quantified from the ROIs in (G), the 406 
hemisphere that received TBI (ipsilateral) and the hemisphere that did not (contralateral).  407 
 408 
Supplemental Figure 1. Blueprint of custom head plate. (A, B) Exact measurements (in mm) of 409 
the custom head plate used in the transcranial macroscopic imaging protocol. 3D schematics of 410 
a hollowed out head plate (C) and a whole head plate (D). 411 
 412 
Supplemental Movie 1. Time-lapse imaging of CSF transport after moderate traumatic brain 413 
injury to the left parietal bone.  Duration: 60 min. Scale bar: 1 mm  414 
 415 
DISCUSSION: 416 
We have described a detailed protocol for performing transcranial CSF imaging in live mice using 417 
commercially-available fluorescent macroscopes and tracers. This technique is simple and 418 
minimally-invasive, yet quantitative. In vivo imaging correlates well with sensitive methods such 419 



  

 

as liquid scintillation counting of radio-labeled tracers including 3H-dextran and 14C-inulin after 420 
CM delivery, and with ex vivo coronal section quantification10,18. Validation with two-photon 421 
microscopy demonstrates that CSF tracers seen along cortical blood vessels under the 422 
macroscope are primarily located within perivascular spaces of the MCA and its branches10. 423 
These CSF inflow pathways are a critical component of the glymphatic system19. Although not 424 
covered in this protocol, these set-ups can also be used to image CSF clearance pathways such as 425 
the meningeal and cervical lymphatics25,26.   426 
 427 
Improvements in head plate design enables chronic, stable, wide-field imaging of the same 428 
mouse over time. Head plate shape, size, and weight can be tailored for each specific application. 429 
With advances in laser cutting and 3D printing, there are few limitations as to the specifications. 430 
Head plating also allows for longitudinal imaging of either anesthetized or awake animals and the 431 
ability to image through an intact skull avoids neuroinflammation and edema associated with the 432 
placement of cranial or thin skull windows27-29. This is an important advantage since stereotaxic 433 
delivery of fluorescent tracers through the cortex into the striatum or lateral ventricles using a 434 
cranial burr hole greatly reduce glymphatic function20,26. The large gantry and working distances 435 
of most commercial macroscopes allow for mice to be fixed to the stage in various configurations, 436 
including running wheels or floating mazes. Mice can be trained and habituated to being head 437 
fixed to the microscope stage during the 5-7-day recovery period to facilitate awake imaging30. 438 
 439 
One of the principal limitations of this method is the low penetration depth of the macroscope 440 
compared to two-photon microscopy10. This device is capable of resolving only a few millimeters 441 
of the cortical surface below the intact skull. However, while this limits the imaging of processes 442 
occurring deeper down in the tissue, it is generally not a problem for glymphatic analyses since 443 
the major routes of entry are primarily located around the main arteries of the dorsal cortical 444 
surface. Despite being unable to resolve deeper structures, macroscopes with high efficiency 445 
scientific CMOS cameras have great fluorescence detection; despite tracer not being located at 446 
the brain surface, total fluorescence intensity correlates with the amount of tracer found in the 447 
brain at every time point after the start of the CM injection10. These parameters are improved by 448 
the use of far-red, near-infrared, or infrared tracers since imaging at these longer wavelengths 449 
reduces tissue auto-fluorescence and the scattering of light, and have a superior signal-to-noise 450 
ratio than lower emission wavelength fluorophores. The standard macroscope enables imaging 451 
of more than one tracer in the same experiment. Depending of the configuration of the 452 
macroscope, the filter turret has to rotate between acquisitions, drastically reducing the 453 
temporal resolution that can be obtained. This can be improved by the use of tunable LEDs and 454 
a multiband filter cube. Despite this improvement, multichannel imaging is not truly 455 
simultaneous, since there is a delay in the acquisition while the LED switches between excitation 456 
wavelengths. It is possible to achieve simultaneous dual channel imaging using image splitting 457 
optics that are compatible with most macroscopic set-ups; however, these sacrifice spatial 458 
resolution by dividing the full resolution of the CMOS camera (2048 x 2048 pixel) into two fields 459 
of view with half the resolution (1024 x 1024 pixel). While CMOS cameras are quite adequate for 460 
this utilization, the use of a CCD camera can be applied to this application as well. An additional 461 
factor that reduces temporal resolution is the exposure time required for adequate excitation of 462 
the chosen fluorophore, which normally ranges between 50 - 1000 ms. This can be further 463 



  

 

optimized by using either 2x2 or 4x4 pixel binning, which reduces the exposure time and 464 
increases the frame rate, at the expense of spatial resolution. Despite these limitations, 465 
transcranial macroscopic multichannel imaging is capable of achieving frame rates between 10-466 
20 Hz with high spatial resolution.  467 
 468 
Recent examples in transcranial macroscopic imaging have used aquaporin-4 (AQP4) knock out 469 
mice10,20 and platelet-derived growth factor B (PDGF-B) retention motif knockout mice22 to 470 
demonstrate the importance of AQP4 and PDGF-B in the glymphatic system. The studies used 471 
C57Bl6 wildtype mice to compare to the knockout mouse lines. They transcranially imaged the 472 
mice for a duration of 30 min using fluorescent tracers and the results concluded that the 473 
knockout lines had dramatically reduced CSF influx compared to wildtypes. 474 
 475 
These properties make transcranial optical imaging an ideal technique to study CSF transport, 476 
especially between 2 or more cohorts of animals. It permits measurements of intracisternal 477 
tracer kinetics in live mice at a micron scale resolution, at a fraction of the cost of other in vivo 478 
imaging modalities. This technique allows the study of the glymphatic system in a physiological, 479 
non-invasive way, and has been useful in helping elucidate some of the factors that regulate its 480 
function in health and disease10,20,25. However, its most exciting attribute is its potential to 481 
answer future questions about CSF hydrodynamics. 482 
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14. Transfer, Governing Law. This Agreement may be 
assigned by JoVE and shall inure to the benefits of any of 
JoVE's successors and assignees. This Agreement shall be 
governed and construed by the internal laws of the 
Commonwealth of Massachusetts without giving effect to 
any conflict of law provision thereunder. This Agreement 
may be executed in counterparts, each of which shall be 
deemed an original, but all of which together shall be 
deemed to me one and the same agreement. A signed copy 
of this Agreement delivered by facsimile, e-mail or other 
means of electronic transmission shall be deemed to have 
the same legal effect as delivery of an original signed copy 
of this Agreement. 
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Please take this opportunity to thoroughly proofread the manuscript to ensure that there are no spelling 

or grammar issues. 

We have read through the manuscript and fine no spelling or grammatical issues. 

Please revise the text in Protocol to avoid the use of any personal pronouns (e.g., "we", "you", "our" 

etc.). 

We have removed all personal pronouns from the text.  

 

3. Please do not highlight notes/cautions for filming. 

We have removed all highlighting from “notes” and “Cautions.” 

 

4. Please avoid long steps (more than 4 lines). 

All steps have been reduced to 4 lines or fewer. However, we believe that the following protocol steps 

will be more effective if they are kept as the original: 

 

“2.9After inserting the CM cannula, apply a mixture of dental cement with cyanoacrylate glue to the 

ventral side of the head plate around the border and place it on the skull so that the anterior border of 

the head plate aligns with the posterior tip of the nasal bone and the posterior border aligns with the 

anterior aspect of the interparietal bone, making sure that the sagittal suture (midline) is centered and 

straight relative to the window (Figure 1B). “ 

“5.1 Based on the fluorescent tracer being infused, determine the excitation wavelength and the exposure 

time for each channel. Choose the shortest exposure time necessary to visualize the tracer in order to 

maximize the temporal resolution of the time-lapse imaging. This exposure time will be used for all 

subsequent experiments aiming to compare CSF transport between different animals.” 

5. Step 1.1: Please ensure that all text is written in the imperative tense. 

Step 1.1 is now in the imperative tense: 

” Sterilize all surgical instruments and head plates before surgery.” 

 

6. 1.2: Please ensure that all text is written in the imperative tense. 

We have removed the first part of Step 1.2 and made it into a note and the second part of 1.2 is now in 

imperative tense: 

 

NOTE: Fluorescent tracers are delivered directly into CSF via a cisterna magna cannulation. For 

detailed instructions on this procedure, please refer to Xavier et al9.  

Briefly, using a needle driver, break the tip of a 30G x ½ inch needle, ¾ of the way down, and place the 

blunt end of the needle into one end of polyethylene 10 (PE10) tubing (about 45 cm long). Make sure 

that only the bevel is protruding out of the border of the PE10 tubing. 

7. 7.1: Please ensure that all text is written in the imperative tense. 

Step 7.1 has been made into a note: 

 

Rebuttal Letter Click here to access/download;Rebuttal Letter;Sweeney et al
Editorial comments.docx

https://www.editorialmanager.com/jove/download.aspx?id=1026882&guid=abf20c18-ef7b-4881-98c2-26f83e93402a&scheme=1
https://www.editorialmanager.com/jove/download.aspx?id=1026882&guid=abf20c18-ef7b-4881-98c2-26f83e93402a&scheme=1


NOTE: Matlab-based analyses, such as CSF front-tracking can extract large amounts of quantitative data 

from the tracer fronts in these imaging datasets10,22. However, these file types can also be easily 

imported and analyzed in open-source image analysis software like Fiji.23  

8. 7.2: Please ensure that all text is written in the imperative tense. 

Step 7.2 is now Step 7.1 and has been changed to imperative tense: 

 

1.1. Import the image stacks into Fiji using the Bio-Formats import tool. This function will preserve the 

file metadata which includes the time and pixel resolution. Save the image stack as a .tiff file.  

9. 7.4: Please ensure that all text is written in the imperative tense. 

Step 7.4 has been made into a note: 

NOTE: CSF transport can be quantified in two main ways: 1) mean fluorescence intensity over time or 2) 

influx area expressed as a percentage of the ROI or total area (mm2) after having applied a threshold. 

The latter method (Figure 1H) will be described in the next steps. 

 

10. 7.7: Please ensure that all text is written in the imperative tense. 

 Step 7.4 (now step 7.5 has been written in imperative tense: 

 

Convert the ‘%Area’ value into mm2 using the ‘Area’ value of the ROI from the output. The ‘%Area’ values 

reflect the percent of the dorsal cortical surface with CSF tracer.    
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Supplemental 3D printing file

Click here to access/download
Supplemental Coding Files

headplate.stl
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